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1. Translation Quality Assurance (QA) in CAT tools
e SDL Trados Studio 2011 (see Figure 1):
0 Document Verifier
QA Checker
Terminology Verifier
Tag Verification
XML Validation
0 see also this blog article about terminology verification in Trados Studio
e memoQ 5.0 (see Figure 2)
0 The QA configuration pane consists of five tabs: Segments and terms; Numbers;
Punctuation; Spaces, capitals, character; and Inline tags.
0 QA check can also be done for translation memories
O Quality Assurance in memoQ webinar
e Wordfast 3 Pro (see Figure 3)
0 Transcheck: Edit > Preferences > Transcheck (Forbidden characters, Partial,
Punctuations, Terminology, Untranslatable). See also Using Transcheck.
e SDL Trados 2007
O Available in TagEditor (Tools > Plug-ins > Verifiers > SDL Trados QA Checker 2.0)

O O OO

2. Translation Quality Assurance (QA) and Translation Memory Maintenance with QA tools

e ErrorSpy (see Figure 4): “Trados unclean files or text files which contain both languages
alongside each other, sentence by sentence (source sentence and translation separated
by any separator you wish). Similarly you can check Translation Memories (Trados TXT
format or TMX files), Trados TTX files, Transit XV files or XLIFF files.” Includes an internal
editor, a spell-checking function (for a very limited number of languages) and an XML
validation check.

e QA Distiller (see Figure 5): TTX, XLIFF (incl. SDL and memoQ XLIFF), STF, TMX. Editing in
an internal editor or TagEditor.

e Verifika (see Figure 6): TTX, SDLXLIFF, XLF/MQXLIFF/MQXLZ (memoQ), TXML
(WordFast), TMX (additional bilingual formats will be added). Includes an internal editor
and a spell-checking function (MS Word or Hunspell).

e ApSIC Xbench (see Figure 7): XLIFF, TMX, TTX, SDLXLIFF, TXML, ITD, etc. New version also
includes a spell-checker (Hunspell; limited number of languages). Project Checklist and
Personal Checklist. Limited number of checks compared to others. However, has a very
powerful search function for bilingual files. No internal editor but can be linked to
external editors.


http://www.finntranslations.com/
http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Edit_View/Translating/How_Set_QA_Check.htm
http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/Ref/Verification/Terminology_Verifier.htm
http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/FileTypes/Tag-Check-Page.html
http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/FileTypes/XML-Validation-page.html
http://tradoshelp.wordpress.com/2011/03/24/terminology-verification-%E2%80%93-i-had-forgotten-this/
http://kilgray.com/memoq/50/help-en/index.html?memoq_help_title_page.html
http://kilgray.com/webinars/quality-assurance-memoq-english-010144
http://www.wordfast.com/WFP2/PM_Using_PM_plug-in/Transcheck.htm
http://www.wordfast.com/WFP2/Wordfast_Pro_Help.htm#PM_Using_PM_plug-in/Transcheck.htm
http://www.dog-gmbh.de/software-produkte/errorspy.html?L=1
http://www.qa-distiller.com/
http://e-verifika.com/
http://www.apsic.com/en/products_xbench.html

e Okapi CheckMate (see Figure 8): any bilingual or multilingual file format supported by
the Okapi filters, for example: XLIFF, TMX, PO, TS, TTX, Trados-Tagged RTF.

3. Translation Memory Maintenance in CAT tools
Built-in functions in CAT tools (such as Trados Studio, memoQ and Wordfast Pro) for
editing, searching, filtering, importing/exporting TMs

Trados Studio 2011

e Format: SDLTM

e Import: TMX, SDLXLIFF, TTX, ITD

e Export: TMX

e Transfer: SDLTM

e Translation Memories view > File >>

e Translation memory editor

e Blog articles about TM maintenance and TM fields

memoQ 5.0

e Format: MTX (several files) and MTM (one file)

e Import: TMX, CSV

e Export to TM: from LiveDocs corpus (bilingual DOC/RTF, TTX, XLIFF)
e Export: TMX

e Transfer: TMX

e Resource console > Translation memories

e Translation memory editor

Wordfast Pro 3.0
e Format: TXT (Wordfast Pro format)
e Import: no import function but TM content can be copied and pasted in a text editor
e Export: TMX, TXT
e Transfer: TXT
e Translation memory > New/Select TM > Translations > Translation Memory > Local
e Translation memory editor: TM Administration perspective
0 somewhat limited: no filters, no regular expressions (regex)

4. Translation Memory Maintenance in Text Editors
Translation memories in TMX and TXT format can be edited in text editors that can handle
large files, such as UltraEdit. UltraEdit has also good find and replace functions that make it
easy to do repetitive and complex searches and replacements quickly.
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http://www.opentag.com/okapi/wiki/index.php?title=CheckMate
http://www.opentag.com/okapi/wiki/index.php?title=Filters
http://www.opentag.com/okapi/wiki/index.php?title=XLIFF_Filter
http://www.opentag.com/okapi/wiki/index.php?title=TMX_Filter
http://www.opentag.com/okapi/wiki/index.php?title=PO_Filter
http://www.opentag.com/okapi/wiki/index.php?title=TS_Filter
http://www.opentag.com/okapi/wiki/index.php?title=TTX_Filter
http://www.opentag.com/okapi/wiki/index.php?title=Trados-Tagged_RTF_Filter
http://producthelp.sdl.com/SDL_Trados_Studio_2011/client_en/TM_View/TM_Open_a_Translation_Memory.htm
http://tradoshelp.wordpress.com/2011/05/17/upgrading-importing-and-exporting-translation-memories-in-trados-studio-2009/
http://tradoshelp.wordpress.com/2011/01/27/translation-memory-fields-%E2%80%93-what-where-why-and-how/
http://kilgray.com/memoq/50/help-en/index.html?edit_translation_memory.html
http://www.wordfast.com/WFP2/Working_with_TM_Admin/Using_TM_administration_perspective.htm
http://www.ultraedit.com/

5. Use of Regular Expressions in QA Functions/Tools

Sources of regex information:

http://www.qa-distiller.com/files/CheatSheet.pdf
http://www.codeproject.com/Articles/9099/The-30-Minute-Regex-Tutorial
http://www.regular-expressions.info/

http://regexlib.com and http://regexlib.com/CheatSheet.aspx
http://atril.com/en/content/13-regular-expressions-regex (Dejavu)
http://catology.boisset.eu/Regular+expressions
http://kilgray.com/webinars/regular-expression-based-filters-1700-cet-0 (memoQ)
http://kilgray.com/webinars/regex-masses-english-011749 (memoQ)
http://msdn.microsoft.com/en-us/library/az24scfc

ApSIC Xbench User Guide

Use of regex in CAT and QA tools:

Trados Studio: QA, file filters, find & replace, display filtering, segmentation rules
memoQ: used in Auto-translation rules (incl. page ranges, unit conversions),
Segmentation rules, Cascading filters (for file types), File filters, Internal RegEx Tagger
(Format > Run regex tagger), QA settings (Check auto-translatables)

Wordfast: not in QA features; only in file filters

ApSIC Xbench, CheckMate, ErrorSpy, QA Distiller and Verifika: extensive use of regex

Examples for the presentation:

Ad{2H/7(\d{2pH)/(\d{4p 05/19/2012 vs. 5/19/2012
QA\d{1,2p)/(\d{2p)/(\d{4}D) 05/19/2012 and 5/19/2012
[0-9]{1,}% 75% vs. 75 %

[0-9]{1, }\smm 25 mm vs. 25mm
\d[\s]*-[\s]*\d 5-6 vs. 5-6

1SO\s\d+ ISO 3000 vs. 1SO3000
~nut Nutritious food...

nut$ ...and a hazelnut
nut\s|nut$
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http://www.qa-distiller.com/files/CheatSheet.pdf
http://www.codeproject.com/Articles/9099/The-30-Minute-Regex-Tutorial
http://www.regular-expressions.info/
http://regexlib.com/
http://regexlib.com/CheatSheet.aspx
http://atril.com/en/content/13-regular-expressions-regex
http://catology.boisset.eu/Regular+expressions
http://kilgray.com/webinars/regular-expression-based-filters-1700-cet-0
http://kilgray.com/webinars/regex-masses-english-011749
http://msdn.microsoft.com/en-us/library/az24scfc
http://www.apsic.com/en/products_xbench.html
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#-lv Document Verifier
=@ QA Checker 3.0

- Segments Verification
- Segments to Exclude
- Inconsistencies

- Numbers

- Word List

- Regular Expressions

- Trademark Check
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-4 Default Task Sequence

~ Translation Memories View
@& Colors

= Keyboard Shortcuts

2 Automatic Updates

i Home View

@ Java Runtime Engine Startup

Reset to Defaults

Punctuation
End punctuation

Check that source and target end with the same punctuation
[] Check for Spanish punctuation (j,¢.! and ?)
Check for unintentional spaces before:

1%

["] French compliant check (spaces are intentional)
Extra dots and spaces
Check for multiple spaces

Check for multiple dots
[ 1gnore ellipsis dots (...)

Check for extra space at the end of target segment
Capitalization check

[] Check capitalization of initial letters

[] Check consistency of global capitalization
Check for brackets
Check brackets

Figure 1. Trados Studio 2011 QA settings
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Edit QA settings

Segments and terms |Numbers | Punctuation | Spaces, capitals, characters | Inline tac,s|

Consistent translation

Verify that identical segments are translated consistently

Warn if forbidden term is used

Segment length

[] Check length of translation in proportion to source

|:| With formatting '.é.' Source to target '.:_.' Bidirectional
|:| Case-sensitive ( _' Target to source
Terminology Other
I [] Check for consistent use of terminology [ Wam if target segment equals source segment :
(@) Source to target
Target to source [ Wamn if target segment is empty
Both ways |:| Check bold. italic. and underline

[] Check auto-translatables

Average target [ source length ratio (characters) 1.00 =
Average target [ source length ratio (words) 1.00 2
Allowed deviation (characters) 50 *| % (min) 150 | % (max)
Allowed deviation (words) 50 *| % (min) 150 | % (max)
[] Check maximum segment length based on value in cell's comment
( ][ canca || Help

Figure 2. memoQ 5.0 QA settings
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5 | Transcheck -
||
[» General :
I b Spelling Enable Transcheck
Temp Files [T] Active transcheck
4 Translations
Auto-Propagation Configuration
Auto-Suggest .
Colors [] Partial
[+ Machine Translation
PM Plug-in [7] Numerical Check
Segmentation Settings [C] Placeable _
[» Terminology -
« [tk [F] Forbidden Chars
Forbidden Chars 3
[] Punctuations -
iy fror -]
Punctuations [7] Untranslatable
Terminclogy :
Untranslatable O Copien s Check
[+ Translation Memory [T Terminology
[ Blacklists

[ First word capitalization check

[ Restore Defauiis] ’ Apply ]

(=]
=

]| Cancel |

Figure 3. Wordfast Pro 3 QA settings (Transcheck)
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[ Project settings - Takkunajaunojaesproject

Wizard
Process filter
= Checks
Acronyms
Completeness
Consistency
Numbers
Customized che
Spelling
Tags
Terminology
Formatting
Typography
XML validation
=l Learning functions
Missing translati
Terminology
List of words no
UT substitute
= Reports
Report settings
HTML report

[V MNumbers [¥]written numbers [ Roman numbers
[¥] Date and time [¥] Currency [ Exclude numbers
[P address [ Numeration [ Hexadecimal
Fhane Fhysical values

IHUTTIRIET

eck decimal separators
[¥|Check decimal sep
eck thousand separators
V] Check th dsep
[] Accept alternative separatars
gnore number if letter at beginning of war
11 herifl heginning of ward

[lignore number if lstter at end of word

[¥]lgnore & number format in blocks of digits

-Raman number

“Miritten number.

~Date and tim

~Fhysical walu

[]only Sl units
Space before unit

Different units
() Ignore values (@) Marmalize

Tolerance: O

Unit database

() Always errar

Diata source: ICSVfiIe

Open command:

Unit:

Base unit:

Base factor field:

Base offset:

I= 5l unit;

Tolerance:

-IP addres

-Mumeration

-Hexadecimal
Fhan

Allowed parentheses: [

4 1l 2 Allowed separatars: -

Help l Load configuration... ” Save configuration_..

Figure 4. ErrorSpy 6.2
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r G’i‘ QA settings | = | = 2%

| Orizzions I Incunsistenciesl Formatting | Terminu:ulu:ug_l,l|

Language independent | Language dependent|

Select the checks to be performed | Selectall || Clearal

Spacing
Congecutive spaces
Inconziztent leading and trailing spaces

Punctuation
Congecubive punctuation mark
|:| End of zegment punctuation
|gnore trailing bracketz and quatation markz
Brackets
|:| MHor-matching pairs
Leading brackets outzide tranzlation unit

Diifferent count

Tabs
|:| Different count

Capitalization
Initial capitalization
Entire capitalization

Figure 5. QA Distiller 8.5
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L4 Verifika - QA webinar demo EI @

Home
Files Protection Common Consistency Terminology Spelling E Save Toals Check @
Omissions Multiple spacing Language specific [ English (US) vl =
Punctuation at the end of ment | =
Untranslatables @ == Punctuation °
Ignore quotes and brackets space before
Punctuation and spacing -
Double punctuation s
Quotes and apostrophes Spaces around punctuation - -
no space before  ...:17
Spaces around special signs (percent, etc.)
Measurement
no space after
Leading and trailing spaces P
Tags ; Special signs
Bracket matching
Numbers and ranges [ | 1gnore inequality signs space before ©s
space after ™M@®%% 08

Miscellaneous

no space before = ™®%%e

no space after

Figure 6. Verifika 1.2
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€2 APSIC Xbench i —— e (5 [
Project View Internet Tools Help

26| ®o 2| [@ o= @ aad ¢ = & ool %l#lee € o

Projectl Interngt  ClA |Instructions|
Check Grou List of Checks Option Filter lssugs
— Untranslated Segments Orly New Segments @ Show Al Zheck Ongoing Translatior|
Content Inconsistency in Source [~ Exclude ICE Segments " Show hark
Checklists Inconsistency in Target C&se—sensitive Incansistend | € Hide Marke Run Project Checklists |
Target same as Source r Ignore_Tags =
Jlear Al Marki Fun Personal Checklists |
Error Description > Source Target -

Numeric Mismatch

derno text Findocx_en-US_fi-FIl. 0%
Numeric Mismatch

derno text Findocx_en-US_fi-FI.. 0%
Numeric Mismatch

demo text Fin.docx_en-US_fi-FI... 022
Repeated Word

derno text Findocx_en-US_fi-FI.. 0%
Target same as Source

demo text Fin.docx_en-US_fi-FI... 022

Use hotwater = 104 °F (= 40 °C).
There are twenty participants.
The distance was 100 miles.
Target has repeated words.

Source and target are identical.

Kayta kuumaa vetta (= 40 °C). —
Osallistujia.on 20.

Valimatka ol 150 km.

1

Kohteessa on on toistuvia sanoja.

Source and target are identical.

< | m

| »

(9]
«  Numeric Mismatch
e There are twenty participants.
e Osallistujizon 20,
o (0%-Translated

o CilUsers\Tuomas\DesktopiTranslationsiTrainingh TH Q& workshop 201 2idemo text Fin.docs_en-US_fi-Fl.sdhdiff

Detail I

[

[

Figure 7. ApSIC Xbench 2.9
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u Quality Check Configuration I u

General |Length |In|ine Codesl Patterns | Characters | LanguageTool | Terms |Other Settings|

Text unit verifications
[Always On] Warn if an entry does not have a translation
Warn if a target entry has a difference in leading white spaces

Warn if a target entry has a difference in trailing white spaces

Segment verifications

[Always On] Warn if a source segment does not have a corresponding target

[Always On] Warn if there is an extra target segment

Warn if a target segment is empty when its source is not empty

Warn if a target segment is not empty when its source is empty

Warn if a target segment is the same as its source (for segments with text)
Include the codes in the comparison

Warn on doubled words {e.q. "is is” in "This is i5 an example™)
Exceptions (words separated by ;' e.g. "vous;nous”):

sievous

” Cancel ]

Figure 8. Okapi CheckMate
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